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INTRODUCTION 

The LC220 is a programmable logic and timing controller for coordinating and 

synchronizing lab equipment and physical experiments. The LC220 provides 

clocks, counters, triggers, and many other useful functions, with up to 5 ns 

resolution and 100 ps accuracy. 

As you are well aware, controlling and synchronizing experimental equipment 

are often the most tedious tasks you’ll face in the lab. Experimenters regularly 

build their own controls from scratch or piece together systems from the limited 

offerings on the market. The LC220 simplifies your control setup, so you can go 

about the business of gathering data. 

The LC220 consists of two components: Trig220 software and the LC220 logic 

and timing controller. Trig220 lets you configure and run experiments from a 

simple graphical interface. The LC220 controller provides the connections and 

control for your experimental devices.  

Parts list 

Your LC220 package should include the following items: 

1. LC220 controller 

2. AC wall transformer 

3. Trig220 software installation CD with user’s manual 

4. 9-pin RS232 cable 

If any parts are missing or damaged please contact LabSmith support. 

Specifications 

Trig220 software will run on any PC-compatible computer running Microsoft® 

Windows® XP, or newer. Drivers for National Instruments’® LabVIEW™ 

software are also available for download. See http://www.labsmith.com for more 

information. 

The LC220 includes two TTL-compatible inputs and two TTL-compatible 

outputs. Voltages in the range 2.5 – 5 V are TTL “highs” and voltages in the 
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range 0.0 – 0.2 V are TTL “lows.” Intermediate voltages should not be present 

on inputs and outputs except during transitions. The inputs and outputs are 

protected against connection to 115 VAC. When disconnected the inputs are 

read as TTL “highs.”  

The LC220 can be connected to/ disconnected from the PC at any time without 

damage to either unit. This ability allows you to program to LC220 at your 

computer, then to take the unit to the experiment area for stand-alone use.  

Basic functions 

The LC220 provides two functional channels, or internal signal paths.  

At any time, each channel can be assigned one of eight timing modes. Timing 

modes include clocks, counters, delayed triggers, etc. You can set various 

properties for each timing mode—for example, the delay length on a Delayed 

Trigger. All modes are aligned to a time base derived from an internal or 

external clock, allowing resolution down to 5 ns. 

Each channel also includes logic settings which specify the conditions that will 

trigger the channel. A channel can be triggered by logical combinations of 

signals from the inputs and/or the output of the other channel.  

All settings and setting profiles for a particular experiment can be stored as an 

experiment file on your computer. Experiment files bear a .tr2 extension. 

How you will use the LC220 

In most cases, you’ll use the LC220 as follows: 

1. Using the Trig220 software, open an existing experiment file, or create a 

new file. 

2. In Trig220 (or LabView), program the properties and logic for each 

channel and for the experiment as a whole. 

3. Send the properties and logic to the LC220’s memory. 

4. Test your program by simulating triggers and examining the outputs using 

the LC220’s channel LEDs and/or an oscilloscope or other diagnostic tool.  

5. Plug your experimental equipment to the LC220. 
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6. Run the experiment, using the LC220 by itself or leaving it tethered to the 

PC.  

Installing Trig220 Software 

Insert the Trig220 Software disk in your CD-ROM drive and execute the 

setup.exe file. 

Setting up the LC220 

1. Verify that your wall socket provides AC voltages within the range setting 

on the wall transformer supplied with the LC220.  If the voltage range is not 

correct, contact LabSmith (support@labsmith.com) for an alternate.  DO 

NOT connect the wall transformer to a socket that is beyond the 

transformer’s range setting.  Plug the transformer into an appropriate 

socket and connect the power to the LC220.  

2. Connect the 9-pin cable to the back of the LC220 and to a free serial port on 

the PC.  

3. Press the Power button on the front of the LC220.  

4. From your computer, run Trig220.exe to launch the Trig220 software. 

5. From within Trig220, select View>Communications options…. The 

Communications properties screen will open. 

 

6. Select the port to which the LC220 is connected. The LC220 will 

automatically detect the baud rate, which is typically set to 38400. If the 

RS232 cable running to your LC220 is greater than 30 m long, you may 

need to lower the baud rate to achieve reliable communication. 

mailto:support@labsmith.com
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 Field upgradeable software 

The firmware in the LC220 is field upgradeable, allowing access to new timing 

modes and capabilities as they become available.  

To upgrade the firmware, download the latest version from www.labsmith.com. 

Then choose “Update Firmware” on the Actions menu to load data from that file. 

Getting help 

This guide is your main source for information on operating the LC220 and 

Trig220 software. The guide is also available in an Abobe® Acrobat® Portable 

Document Format (pdf) file for electronic viewing.  

Check the LabSmith web site (www.labsmith.com) for helpful applications notes 

and other technical information to help you use the LC220. 

If you are unable to find the information you need, please contact our technical 

support team at (925) 292-5161, or e-mail us at info@labsmith.com. 

If you need to contact support, please let us know your LC220 serial number 

(located on the bottom of the unit) and the version of software you are using. To 

determine the software version number, select “About Trig220” from the 

Help menu. 
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OVERVIEW OF LC220 CONTROLS 

The LC220 is the control unit and interface for your experimental equipment. 

You will program it using the Trig220 software. Once you’ve designed, tested 

and downloaded your program, you can control the LC220 from the computer, 

or you can run it in stand-alone mode.  

Indicators and controls on the LC220 will help you run your experiments. You’ll 

learn all about these functions in the Experimenting section later. For now, we’ll 

give you a short tour of the inputs, outputs and controls so you can work with the 

unit while you learn to use the Trig220 software. 
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Inputs and outputs 

The LC220 includes the following connectors: 

- a 2.1 mm power jack (center positive) for 6 to 9 V DC, 0.6 A power 

source 

- a 9-pin RS232 jack to connect to the Com port of your PC 

- two channel input BNC jacks (in1 and in2), normally high (5 V) 

- two channel output BNC jacks (outA and outB), normally low (0 V) 

- in1 doubles as an input jack for an optional external clock source. 

The input and output voltages conform to the TTL standards. 

 Panel controls 

There are three buttons on the LC220.  Trigger A and trigger B respectively 

force channels A and B to be triggered.  The effect this has on the channels 

depends on the timing mode of the channels.  The third button, Reset, causes 

both channels to have their timing modes reset.  Again, the effect of the reset 

depends on the channel settings.  These settings are detailed in the following 

sections. 
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 TRIG220 SOFTWARE INTERFACE 

Trig220 has been designed exclusively for setup and control of the LC220. 

You’ll use Trig220 to set the timing properties and logic for each of the channels 

and to set up overall properties for the experiment. 

Main screen 

When you run Trig220, you’ll be greeted by the Main screen:  

 

 

          

 NOTE: At start-up, the Main screen will show the default 

program, which sets both channel outputs to a fixed low state.   

         

From this screen you’ll control or access all of Trig220’s functions. Most 

Trig220 functions can be accessed in two ways by selecting an option from a 

pull-down menu or by pressing a button on the Main screen.  
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1. Menu options: 

The File menu lets you open, close and save experiment files (.tr2 files). 

The Edit Menu lets you cut, copy and paste text as you edit your 

program. 

The View menu lets you set up the Trig220 interface. Choose to display 

or hide the tool bars and status bar, select the font used in Trigger, and 

set up communications with the LC220. 

 The Actions menu lets you modify the LC220 settings. 

2. The buttons are as follows: 

 

The Reset button  resets both channels of the LC220. Retriggering 

counters and delay settings are reset as well.  

The Program all settings button  updates the LC220 with all 

current settings. 

The Online/Offline button  toggles between Online and Offline 

mode.  In Online mode this button is depressed, the Com port is open, 

and settings are transferred to the LC220.  In Offline mode, this button is 

not depressed, the Com port is available for other programs and settings 

are not transferred to the LC220.  Offline mode is convenient for 

developing .tr2 settings without an LC220 attached. 

 The Main window panel shows and controls all of the channel settings. 

This summary may be printed for review and documentation purposes. 

The text is not freely editable and must be modified through the dialogs. 

Double-clicking on selected parts of the summary opens the dialog 

needed to edit the text.  
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Time base settings 

The “Time base settings” dialog lets you control the time base used by the 

LC220 for timing.  The LC220 measures, delays, and pulses in increments of this 

time base.  For higher timing resolution, you can use a higher clock multiplier.  

For longer delays, select a lower clock multiplier.  A variety of multipliers are 

available to optimize the increment for your needs. To reach this screen, click 

“Set time base options…” from the Action menu. 

 

Clock source 

The LC220 can derive its time base from an internal 25 MHz oscillator or from a 

TTL pulse train provided to In1.  If the time base is derived from the external 

input, you must specify the frequency of this time base so that Trig220 can set 

the LC220 timing correctly.  If the clock frequency specified is 10% higher than 

actual, the channels using this time base will be 10% long on delays and 

duration. 

Clock multiplier 

The clock source is multiplied by a user-specified factor to form a high-

frequency source for the time base.  For example, a multiplier of 4 X on the 25 

MHz internal oscillator produces a clock of 100 MHz for a time base of 10 ns.   
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Time base 

The calculated time base is indicated in this window.  This must not be less than 

5 ns or greater than 1000 ns for proper operation.   

General options 

The “General options” dialog lets you enable and disable the channel outputs 

and lock or unlock the panel buttons.  To open this dialog, click “Set LC220 

options…” under the Actions menu. 

 

Disable/enable outputs 

Disabling outputs prevents the LC220 from sending trigger pulses to its output 

connectors regardless of the inputs or the actions of the channels.  Enabling the 

outputs allows the LC220 to send trigger pulses to its output connectors.  These 

functions are nonvolatile: the enabled and disabled states are restored on power 

cycle.  

Lock/unlock panel 

Lock or unlock the front panel buttons using the “Lock Panel” and “Unlock 

Panel” buttons. This functionality is handy, for example, in an embedded control 

application where the LC220 should function only in stand-alone or computer-

controlled modes. When the panel is locked the buttons are not illuminated.  

When the panel is unlocked, the front-panel buttons are illuminated. 

Like the enable/disable I/O functions, these settings are nonvolatile and are 

restored on power up. 
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CHANNEL PROPERTIES 

Channel properties screen 

Both channels have a Settings screen in the main application window in which 

you’ll select the timing mode, set the timing properties, and establish the logic 

that will determine when the channel will trigger. 

 

  

 

Channel properties are organized by tabs. The tabs that are relevant for a 

particular timing mode appear automatically when that timing mode is selected. 

For convenience, all settings are retained and saved, including those for timing 

modes that are not currently selected. 

Four additional buttons appear next to the tabs: 
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- Enable restores channel functions following a temporary disable. The 

front panel LED for that channel will glow to indicate the channel's 

status.  

- Disable temporarily disables the channel. The channel remains fixed in 

its “quiescent state” (see Quiescent States below). The front panel LED 

for that channel will be unlit (See Running Experiments: Channel 

LEDs). 

- Reset reinitializes the internal trigger counters and sweep timing for the 

current channel. This function can be called simultaneously for all 

channels by pressing the “Reset” button on the main tool bar. 

- Force Trigger lets you simulate a valid input signal for the channel 

(see Channel Properties: Logic for more). This button, which is only 

available with functions that can be triggered, is useful both for 

troubleshooting your channel settings and implementing software 

control of experiments. You can also force-trigger a channel from the 

LC220 panel (See Running Experiments: Force Trigger). 

Quiescent states 

When you disable a channel, its input will not change the output. The “quiescent 

state” of a channel is the setting of its output when the channel is disabled. You 

can set each channel’s quiescent state to be a TTL high (3.5–5 V) or low (0–0.2 

V) to provide a safe signal to the output device if you need to abort an 

experiment or stops its progress.  

The method for setting the quiescent state depends on the timing mode. Most 

modes include an “Invert Output” option which sets the output normally High.  

Logic 

A channel can be triggered by logical combinations of signals from the inputs 

and/or other channel output. Channel logic determines the combination of 

signals that triggers the channel.  

To define when a channel will trigger, open the channel’s Settings screen then 

click the “Logic” tab. This tab only appears for timing modes which respond to 

logic. You will select a trigger logic assignment for the channel from a list of 

options. 
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 NOTE: Some timing modes do not respond to trigger logic. 

For example, a channel set to operate as a clock will continue 

to run regardless of its input. 

         

Logic assignments 

The logic processor assigns the logical combination of external inputs (In1 and 

In2) and other channel output that will trigger each channel. Logic assignments 

have the following format: 

[the channel to be triggered] = [the conditions that will trigger it]. 

Here is an example:  

InB = In2. 

This assignment means, “Channel B will be triggered when the signal on In2 

goes TRUE (reaches ~5 V).”  
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The assignment: 

InB = Not In2 

 

means “Channel B will trigger when the signal on In2 goes FALSE (drops below 

0.2 V).”  

You can employ compound arguments in logical assignments, such as: 

InB = Not OutA And In2. 

This means, “Channel B will trigger when the output of Channel A is FALSE 

and In2 is TRUE.” 

          

 NOTE:  LC220 inputs are TRUE by default if nothing is connected 

(i.e., the input is normally weakly pulled high). Grounding an input 

switches its state to a logical FALSE.  

         

 

Experimenting With Channel Logic 

This brief example will show you more about channel logic: 

1. Connect a normally-open switch to In1 and another to In2. 

2. Connect an LED to OutA. 

3. Choose “Output = Input” from the “Timing mode” list for Channel A. 

In this mode, the output of Channel A is always the same as its input. 

4. Select the “Passive” tab and choose “Output = Input.” 

5. Select the “Logic” tab and select 

inA = in1. 

6. Click the “Program all settings” button .  

The OutA LED should be glowing, indicating that the output is TRUE, or 

HIGH (since LC220 inputs are normally HIGH). When you close Switch 1 

the LED will turn off, indicating that the output is FALSE, or LOW. 
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       _  

 NOTE: The Channel A LED on the LC220 glows green while the 

channel output is LOW, or red when the output is HIGH. But don’t be 

confused! The channel LED does not always indicate the channel’s 

output state–only in certain Timing modes. You’ll learn more later in 

the Timing modes section. 

         

7. Next, change the logic assignment to  

InA = Not In1. 

8. Click the “Program All Settings” button . The LED at Output A 

will now remain off until you close the switch. 

9. Change the logic assignment to 

InA = Not In2. 

10. Click the “Program All Settings” button. The LED at Output A will 

remain off until you close Switch 2. 

11. Lastly, change the logic assignment to:  

InA = Not In1 And Not In2; 

12. Click the “Program All Channels” button. The LED at Output A will 

remain off until both switches are closed. 

Timing modes 

In the previous section you learned that logic defines how channels are triggered. 

In this section you’ll use the LC220 timing modes to determine how the channels 

will respond.   

Each channel can be configured to operate in one of eight modes:  

- Fixed output 

- Output=Input (Passive mode) 

- Statically delayed pulse 

- Clocked pulse stream 

- Validated trigger input (Noise suppression mode) 
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- Dynamically delayed pulse 

- Timer 

- Toggled output.  

When a timing mode is selected, the relevant property tabs will be displayed.  

         

NOTE: All timing property tabs include a space for Notes. These notes 

are saved and appear in the Main Screen program summary area. It is 

good practice to document your settings extensively. As with all 

programming, good documentation will simplify the process of 

creating, debugging and running your experiments. 

          

For each timing mode you’ll be able to set up a simple example to view the 

output of the channel. 

To set up for the experiments later in this section:  

1. Make sure that the LC220 is connected to the PC.  

2. Plug a normally open push-button trigger switch into In1. The button will 

represent our triggering “event.” 

3. Open Channel A’s Setting screen, and select the “Statically delayed 

pulse” timing mode (you’ll learn about Statically delayed pulse mode 

shortly).  

4. Select the “Logic” tab and select the logical assignment:  

InA = Not In1.  

Then click Apply. With this logic, Channel A will trigger when you 

depress the trigger button. 

5. Plug an oscilloscope to Output A to observe the channel output. 

Remember, the output voltage will vary from 0 to 5 V. 

“Apply” versus “Program All Channels” 

Each properties screen includes an “Apply” button which, when clicked, will 

send the current timing properties to the channel on the LC220. The other 

channel function, for example retriggering counters and triggering, is not 

affected.  
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 “Program All Channels” updates the time base settings and all the channel 

settings of the LC220. Both channels are reset. 

Fixed output mode 

 

In this mode, the channel output remains in the selected state (Low or High), 

regardless of the input.  

The panel LED for the channel will glow green when the output is low or red 

when the output is high. 

To try fixed output mode:  

On the “Properties” tab of Channel A, choose “Fixed Output.”  Choose “Low” or 

“High” as the output state, then click “Apply” to save the settings. At Output A, 

the signal will remain a steady TTL logic low or high, depending on your 

selection. 
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 Passive mode (Output = Input) 

 

In passive mode, the output signal equals the input signal or its logical inverse. 

The panel LED for the channel will glow green when the output is Low or red 

when the output is high. 

To try passive mode: On Channel A’s Settings screen, select the 

“Output=Input” timing mode. In the Function box, choose “Output=Input,” then 

Click “Apply” to save the settings.  

When the trigger button is not depressed (i.e., the input signal is low), the signal 

at Output A will be a TTL low. Now, depress the trigger button at Input 1—the 

signal at Output A will go high. If you select “Output=!Input (invert), the 

channel output will remain high until you depress the trigger. 
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 Clocked pulse stream mode 

 

In clock mode, the output of the channel is a steady stream of pulses. You set the 

pulse duration and delay between pulses. A clock channel’s input does not affect 

its output. 

The panel LED for a clock channel will glow green when the output is low or 

red when the output is high.  

         

NOTE: For a high-frequency clock the LED will alternate between 

red and green so quickly that it will appear as a continuous pale 

green, yellow or orange light. 

         

As mentioned earlier, the LC220 can operate with different time bases (see Time 

Base Settings).  With a 5-ns time base (internal clock X 8, the clock pulse and 

duration can range from 0.48 µs to 52.4 ms.  At longer time bases, this range is 

proportionally longer, for example at 320-ns time base (internal clock X 1/ 8) the 

pulse duration can range from 30.1 µs to 3.35 s. 
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To set the pulse duration, select the timing units (seconds, microseconds, 

milliseconds or nanoseconds), then enter a duration in the “Clock high duration” 

box.  

To set the time between pulses, select the units, then enter the duration in the 

“Clock low duration” box. 

A clock’s quiescent state is normally low (See Channel Properties: Quiescent 

States). Check the “Inverted output” box if the quiescent state for the channel 

should be high instead. 

To try Clock mode: 

1. On the Time base settings screen, select internal clock and a clock 

multiplier of “1/8 X”. 

2. On Channel A’s Properties tab, choose “Clock” as the mode, select an 

“on” duration of 100 ms and an “off” duration of 500 ms. Click 

“Apply” to save the settings.  

The signal at Output A will go repeatedly go high for 100 ms then go low for 

500 ms.  

Statically delayed pulse mode 

Upon receiving an input signal, a delayed trigger waits a specified delay time, 

then sends a pulse to the channel output. This mode has several property tabs.  
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Delay  

 

On the Delay tab you’ll specify: 

Delay after trigger The delay between a valid trigger and an output signal 

Duration of pulse The duration of the output signal 

Until Reset The output will remain high after a valid trigger, until the 

channel is reset 

Inverted Output Check the box to set the output high until a valid trigger. 

The range of settings you can use with the delayed trigger depend upon the 

current timing mode: 

 

Time base 5 ns 320 ns 

Delay range 20 ns to 21.47 s 1.28 µs to 1374 s 

Duration range  7.7 µs to 21.47 s.  493 µs to 1374 s 

Delay / Duration 

resolution  

5 ns 320 ns 
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Triggering 

This tab lets you control how the channel will trigger:  

 

Normal  The channel can retrigger an unlimited number of 

times 

Skip N triggers  The channel triggers only after the specified number 

of input pulses (between 0 and 2,147,483,647).  

Retrigger N times  Limits the number of retriggers allowed between 

resets (between 0 and 2,147,483,647). To allow a 

channel to be triggered again after reaching the limit, 

the channel must be reset.  To reset both channels, 

press the “Reset” button on the LC220 or choose 

Actions>Reset in Trig220.  To reset only one 

channel, click the “Reset” button next to the channel 

settings. 

Trigger on rising input  Sets the channel to be edge triggered. In other 

words, an input signal that stays high triggers the 

channel only once.  
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Trigger on input high  Allows the channel to be repeatedly triggered while 

an input is high. This setting could be used for 

generating a low-precision gated clock, for example. 

However, the latency time between retriggers is 

indeterminate (typically around 10 µs) so a clock 

made this way is not suitable for applications 

requiring high precision.  

Sweep 

 

 

To facilitate time-delay scanning experiments, the delay of the pulse relative to 

the trigger can be “swept” or incremented by a specified value each time the 

channel is triggered. The sweep value must be positive. The increment resolution 

is equal to the time base (e.g., as short as 5 ns).  

The panel LED for the delayed trigger will glow green until an input signal is 

detected. The LED will be unlit for the delay time and will glow red for the 

duration time.  What happens next depends upon the channel settings: 
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Retriggering 

enabled? 

Edge 

triggered? 

The channel LED… 

no yes or no remains red (no more triggers accepted) 

yes no glows green (waiting for next trigger) 

yes yes is off; glows green once input goes low. 

To try the delayed pulse mode: 

1. Under Time base settings, choose internal clock X 1/8 (320 ns time 

base).  

2. In Channel A’s properties screen, select “Statically delayed pulse.”  

3. On the Delay tab, enter a delay of 1 s and duration of 500 ms.  

4. On the Triggering tab choose “Retrigger N Times” and set N=0. Choose 

“Input high (level trigger),” then click “Apply” to save the settings. 

5. Click the trigger pushbutton. One second after you push it, the output of 

Channel A will go high for 500 ms.  

6. The channel LED remains red, indicating it is not ready to trigger. Push 

the button again. You’ll see that you cannot retrigger the channel. Click 

the “Reset” button on the LC220—the LED glows green and you can 

once again trigger the channel. 

7. On the Triggering tab, choose “Retrigger N times,” set N=5, then click 

“Apply.” Depress and hold the trigger button. As long as the trigger is 

depressed (i.e., the input signal is high) the channel will continue to 

trigger until the limit is reached. 

8. Again on the Triggering tab, select “Rising Input (Edge Trigger)” then 

click “Apply.” Depress and hold the trigger button. The channel will 

trigger only once, no matter how long you hold the button. Release the 

button and depress it again, and the channel will be triggered once more 

(switch bounce may produce triggers when the button is released). 

9. On the Delay tab, check “Inverted output,” then click “Apply.” The 

output will be the inverse of that described in Step 4. 

10. On the Sweep tab, set the sweep to 0.5 s per trigger, and on the Delay tab 

select Normal. Click “Apply.” The time delay before the output pulse 

will increase with each trigger. 
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Important delay timing considerations 

Once the LC220 has begun a delay sequence, it ignores incoming trigger pulses. 

There is also a delay of approximately 10 μs (at a 5 ns time base) after the 

completion of a delay sequence while the channel resets for the next trigger. This 

effect can be used to skip triggers, but if misunderstood it can cause unexpected 

results.  

For example, in the diagram below, two trigger pulses arrive 100 μs apart. The 

channel is functioning in Statically delayed pulse mode, with a delay of 50 μs 

and a duration of 45 μs pulse. It would: receive the first pulse; wait 50 μs; send a 

45 μs output pulse; and trigger again at the second pulse. But the extra 10 μs 

delay at the end of the sequence will cause the channel to ignore the second 

trigger pulse. 

  

t=50 μs 
output 
pulse sent 

t=100 μs second trigger pulse  t=0 μs first trigger pulse 

t=105 μs channel ready 
for next trigger pulse 

t=95 μs delay 
sequence ends 
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Validated trigger input mode (noise suppression) 

 

The noise suppression function eliminates false triggers due to noise on the input 

signal by requiring the signal to remain high (or low) for a specified duration. If 

the signal drops out during that period, the output will remain low and the 

channel will look for the next input signal. Once an input signal is deemed 

“valid,” a pulse of user-specified duration will be sent to the channel output.  

Unlike an analog filter which “smears” the signal edge, this noise suppression 

function digitally blocks false triggers, retaining the sharp edges on the real 

trigger signal. 

As with Statically delayed pulse mode, you have additional controls over the 

channel.  

On the Validate tab, choose: 

Minimum duration The minimum length of an input pulse that will 

trigger the channel 

Duration of pulse The duration of the output signal 

Until Reset The output will remain high after a valid trigger, until 

the channel is reset 
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Inverted Output Check the box to set the output high until a valid 

trigger. 

 

On the Triggering tab choose: 

Normal  The channel can retrigger an unlimited number of 

times 

Skip N triggers  The channel triggers only after the specified number 

of valid input pulses (between 0 and 2,147,483,647).  

Retrigger N times  Limits the number of retriggers allowed between 

resets (between 0 and 2,147,483,647). To allow a 

channel to be triggered again after reaching the limit, 

the channel must be reset.  To reset both channels, 

press the “Reset” button on the LC220 or choose 

Actions>Reset in Trig220.  To reset only one 

channel, click the “Reset” button next to the channel 

settings. 

Trigger on input high  While the input is high, channel can be repeatedly 

triggered.  

Trigger on rising input  Sets the channel to be edge triggered (i.e., an input 

signal that stays high will only trigger the channel 

once).  

The panel LED for the noise suppression channel will glow green until an input 

signal is detected. It will then glow red until the duration period has elapsed. At 

this point, the LED will respond as follows: 

 

Retriggering 

enabled? 

Edge 

trigger? 

LED 

no yes or no remains red (no more triggers accepted) 

yes no glows green (waiting for next trigger) 

yes yes is off; glows green when trigger goes low 
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To try validated trigger mode: 

1. Under Time base settings, choose internal clock X 1/8 (320 ns time 

base).  

2. In Channel A’s properties, select “Validated Trigger Input” mode.  

3. On the Validate tab, enter a “Minimum duration” and “Duration of 

output pulse” of 1 second each.  

4. On the Triggering tab, select “Retrigger N times,” and set N=50. Click 

“Apply” to save the settings. 

5. Now, depress the trigger button. If you hold the button down for more 

than one second (the minimum duration), the output of Channel A will 

go high. If you release the button before one second elapses, the output 

will remain low, and the channel will wait for another input pulse.  

Timer mode 

 

The counter/timer mode determines the time delay between two separate input 

signals and reports it back to the PC. You can view the counter output in the 

Properties tab.  
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Use the channel’s logic to select the input signals that will be compared by the 

timer (see Channel Properties: Logic above).  

Normally, the counter will report a value each time a pair of pulses is measured. 

To retain the current measurement, check the “Hold measurement” button; the 

counter will not update the delay display until this button is cleared. 

         

NOTE: To switch from Timer mode, first click the Disable button and 

ensure the channel LED is unlit, indicating that the channel is disabled. 

This will help you avoid unexpected behaviors when the counter is 

transmitting measurements rapidly (e.g., >1000 measurements/second).  

         

         

NOTE: When you first run the LC220, channels that are configured as 

counters are initially disabled and must be enabled either by clicking 

the “Enable” button on the channel’s Properties screen, or by using the 

front panel (See Experimenting: Disable/Enable Channels below). 

         

The panel LED for the timer will be green until the first trigger, red until the 

second trigger and off while the count data is reported and the channel waits for 

the input to return low. 

The output of a channel in timer mode is always high. 

         

NOTE: The LC220 may be measuring time differences faster than it 

can display them all on the monitor. 

         

Now, check “Hold measurement.” Note that the displayed measurement does not 

change. Un-check “Hold Measurement”, then check “Hold measurement” again 

to freeze another measurement. 

Dynamically-delayed pulse mode 

The dynamic delay is a unique feature. First, it measures the time difference 

between two pulses, like a counter. Next, it scales that difference by a user-
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defined factor. It subtracts an offset value, waits the duration of the dynamically 

calculated delay, then sends a pulse to the channel output.  

         

NOTE: The dynamic delay is particularly useful for ballistics or gas 

dynamics experiments, in which the velocity of a projectile or wave must 

be calculated and used to time the triggering of an experimental device. 

         

Dynamically delayed pulse mode includes several properties tabs. 

Scaling 

 

In the calculation of the delay, the measured delay between two pulses is scaled 

by a factor of 2N, where –16 < N < 16, or N/16, where 0< N < 256. The former 

scaling is faster and a scaling of 1:1 is fastest. Scaling can typically be done at 

rates > 50 kHz at a 5-ns time base. 

The maximum delay between input pulses is 52 ms at a time base of 5 ns and 3.3 

s at a time base of 320 ns. The maximum delay resulting from the scaling and 

offset calculations is respectively 21.47 s and 1374 s at 5-ns and 320-ns time 

bases. 
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Delay 

 

Added Delay Set an offset value to subtract from the scaled delay 

length. This is useful when accounting for camera shutters 

or other lag times in experimental equipment. The offset 

value can be positive (shortens the delay time) or negative 

(lengthens the delay time) and the resolution is set by the 

time base (e.g., 10 ns).  

Duration of pulse The duration of the output signal 

Until Reset The output will remain high after a trigger until the 

channel is reset 

Inverted Output Check to set the output high until a valid trigger. The 

duration of the pulse and other properties are the same as 

for the delayed trigger.  

Triggering 

The triggering options are the same as those for Delayed Pulse After Triggering 

mode: 
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Normal  The channel can retrigger an unlimited number of 

times 

Skip N triggers  The channel triggers only after the specified number 

of input pulses (between 0 and 2,147,483,647).  

Retrigger N times  Limits the number of retriggers allowed between 

resets (between 0 and 2,147,483,647). To allow a 

channel to be triggered again after reaching the limit, 

press the “Reset” button on the LC220 or choose 

Actions>Reset Channels in Trigger. 

Trigger on rising input  Sets the channel to be edge triggered. In other 

words, an input signal that stays high triggers the 

channel only once.  

Trigger on input high  This option is not used in this mode. 

 

The panel LED for a dynamically-delayed trigger will remain green until a valid 

input signal is detected. When an input signal is detected, the LED will glow red 

until the output signal is sent. At this point the LED will return to green if 

retriggering is allowed, or it will glow red to indicate that no more input signals 

will be accepted. 

To try the dynamically-delayed pulse mode: 

You can simulate the experiment above, using the trigger button to represent 

Sensor 1, and a delayed trigger in Channel B to represent the signal from Sensor 

2. Connect your oscilloscope to the Output C to view the results. 

1. Under Time base settings, choose internal clock X 1/8 (320 ns time base). 

2. On Channel A’s Properties window, select “Delayed Trigger” mode, with a 

delay and duration of 500 ms each. Setup for edge triggering and allow 

retriggering. 

3. On Channel A’s Logic tab, select: inA = not in1; This logic will cause the 

delayed trigger to pulse 100 ms after the button press. 

4. On Channel B’s Properties window, select “Dynamically Delayed Pulse” 

mode. Set up for scaling by 2N, where N = 1, and set the Added Delay to – 

200 μs and the duration to 100 ms. Allow unlimited retriggering. 
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5. On Channel B’s Logic tab, select: inB = outA or not in1.  This routes the 

button push signal and the delayed signal to channel B. 

6. Since you’ve made changes to multiple channels, click the “Program All 

Settings” button.  

Now the test is ready. Depress and release the trigger button quickly. Channel A 

will produce a trigger pulse 500 ms later.  Both the button push and delayed 

signal will appear on the inputs of Channel B.  When Channel B receives the 

button-push signal, it will begin its count. When Channel B receives the delayed 

pulse from Channel A, it will calculate the time difference (500 ms), multiply it 

by 32/16, and subtract the 200 µs offset. 999.8 ms after receiving the signal from 

Channel A, Channel B will send a 100 ms output pulse. 
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 Toggled output mode 

This mode toggles its output state upon every input pulse. It functions like a flip-

flop and is useful for a variety of logical and control purposes. The minimum 

input-pulse state duration is 10 ns and the edge-to-toggle delay is < 20 ns. 

 

The only user settings for this mode are the initial state, which may be either low 

or high. 

The panel LED for the channel will glow green when the output is low or red 

when the output is high. 
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RUNNING EXPERIMENTS 

Once you’ve created a program you’re ready to set up and perform your 

experiment. 

Storing and recalling experiment files 

As mentioned earlier, an experiment file is a document which resides on your 

PC, containing all of the logic, properties, and settings profiles for a particular 

experiment. Experiment files bear the .tr2 extension. 

To save an experiment, choose “Save As” from the File menu. Name the file, 

then store it on your hard drive in an accessible place. 

To reuse an experiment file, choose File>Open, and locate the file. When you 

click “OK,” the file’s settings will appear in Trig220. Click “Program all 

settings” to download the settings to the LC220.  

         

NOTE:  Good file naming protocol will help your experiments go more 

smoothly. For example, if you are saving multiple versions of a 

combustion experiment, store all files in the same directory, with the 

names “combustion1.trg”, “combustion2.tr2”, etc. Or, better yet, use 

descriptive names such as “combust - 50us delay.tr2”, “combust - 60us 

delay.tr2”, etc. 

         

Panel controls and indicators 

The front panel of the LC220 is designed to help you run experiments without 

computer control. This functionality allows you to program the unit at a 

workstation, then to move the unit to the experimental environment. 

Channel LEDs 

As mentioned earlier, the LEDs for each channel provide information on each 

channel’s status: 

1. A green light on a channel typically indicates that the channel is waiting 

for an input trigger.  
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When a channel is in Fixed output, Clocked pulse stream, Output=Input 

or Toggled output timing modes, the green light indicates that the 

output is currently LOW for that channel. 

2. A red light typically indicates that the channel is in the process of 

triggering.  

When a channel is in Fixed output, Clocked pulse stream, Output=Input 

or Toggled output timing modes, the red light indicates that the output 

is currently HIGH for that channel. 

3. When a channel indicator is steadily off, the channel is disabled (see 

Enable/Disable Channels below). The channel indicator also turns off 

during delays and while waiting for the input to return low for an edge 

trigger. 
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The following chart provides an overview of the front panel channel LEDs: 

Mode Off Green Red 

Fixed output -- Output is Low Output is High 

Output = 

Input 

(Passive) 

-- Output is Low Output is High 

Clocked 

pulse stream 

-- Output is Low Output is High 

Statically 

delayed 

pulse 

In delay 

period 

Waiting for trigger; if 

retriggering is on, 

light will glow green 

once input goes low 

In duration period; if 

retriggering is off, 

light remains red 

after duration period 

Validated 

trigger 

(Noise 

suppression) 

-- Waiting for trigger; if 

retriggering is on, 

light will glow green 

once input goes low 

In duration period; if 

retriggering is off, 

light remains red 

after duration period 

Timer Timer 

data is 

being 

reported, 

waiting 

for input 

to go low 

Waiting for first 

trigger pulse 

Waiting for second 

trigger pulse 

Dynamically 

delayed 

pulse 

-- Waiting for trigger; if 

retriggering is on, 

light will glow green 

once input goes low 

In duration period; if 

retriggering is off, 

light remains red 

after duration period 

Toggled 

output 

-- Output is Low Output is High 

         

NOTE: Channel LEDs provide important information about the 

channels, but an oscilloscope remains a useful tool for diagnosing 

channel outputs, particularly for high-speed experiments.  
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Output LED 

The output (right-most) LED glows green when outputs are enabled and red 

when outputs are disabled. (See Running Experiments: Disable/ Enable 

channels below). 

Trigger A and Trigger B 

This function lets you simulate an input trigger on the respective channel, 

regardless of the channel’s logic settings or state. This is a useful way to initiate 

a timing sequence without actually performing the live experiment. You can also 

trigger a channel from within the Trig220 software (See Channel Properties: 

Force Trigger above). 

Reset  

The Reset button returns both channels to the last programmed settings. It resets 

and reinitializes retriggering counters and the delays of any channels that are 

undergoing a delay sweep. 
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GLOSSARY 

Apply Sends a channel’s current timing settings to the 

LC220. 

Baud Rate The speed of communication via the Com port. 

Channel One of eight internal signal paths in the LC220. 

Channel input The signal which feeds one of the eight channels. A 

channel input can be triggered by signals from any 

combination of signals from the input jacks and/or 

channel outputs. 

Channel settings The logic and timing settings which determine how 

a channel functions. 

Com port A serial port on a PC computer. The LC220 

communicates with the computer via an RS-232 

cable connected to a Com port. 

Controller The LC220 hardware unit. 

Counter/timer mode This timing mode determines the time delay 

between two separate input signals. 

Delay The time between the arrival of an input trigger and 

the release of an output pulse. 

Duration The length of an output pulse.  

Dynamically delayed pulse Timing mode measures the time difference between 

two pulses, scales that difference by a user-defined 

factor, waits the duration of that calculated delay, 

then sends a pulse to the channel output. 

Edge triggering This channel setting ensures that an input signal 

which stays high will only trigger the channel once. 

Enable/disable outputs A function which disables or suspends a channel 

(or all channels) temporarily.  

External clock A signal applied to in1 that can optionally be used 

to generate the time base of the LC220. 
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Firmware The internal code of the LC220 controller. The 

firmware, as well as the Trig220 control software, 

can be field-upgraded. Latest upgrades are 

available at www.labsmith.com. 

Input One of two input jacks on the LC220. Signals from 

these inputs can be logically combined to trigger 

either channel. 

Lock/unlock panel A function that disables all front panel functions 

(including the power button) to avoid 

tampering/accidental changes when the LC220 is 

embedded in an experiment. 

Logic The set of assignments that determines when a 

channel will trigger. 

Noise suppression Also called “Validated Trigger Input” mode. This 

timing mode eliminates false triggers due to noise 

on the input signal by requiring the signal to remain 

high (or low) for a specified duration. 

Output One of two output jacks on the LC220. The output 

signals are determined by the timing channels. 

Program all settings A function which sends all logic and timing settings 

to the LC220. 

Programmable logic controller A device which combines logic and timing 

processors for precise control of physical 

experiments. 

Reset Returns all channels of the LC220 to their waiting 

condition. Retriggering Counters and delay settings 

are reset as well. 

Retrigger A channel setting that allows the channel to be 

triggered more than once if subsequent trigger 

pulses are received. 

Scaling In the Dynamically Delayed Trigger timing mode, 

scaling determines the ratio of the distance between 

the two input sensors to the distance of the target. 
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Settings file A PC file (with a .tr2 extension) that contains all 

the logic and timing settings for an experiment. 

Skip triggers A setting that allows a channel to trigger only after 

the specified number of input pulses. 

Statically delayed pulse In this timing mode, a channel waits for an input 

signal, waits a specified delay time then sends a 

pulse to the channel output. 

Sweep In the Delayed Pulse After Trigger timing mode, 

this settings facilitates time-delay scanning 

experiments in which the delay of the pulse relative 

to the trigger must be incremented by a specified 

value each time the channel is triggered. 

Time base The minimum increment of time used by the 

LC220.  This can range from 5 ns to 1000 ns and 

can be generated from an internal or external clock. 

Timer Counter/Timer mode determines the time delay 

between two separate input signals and reports it 

back to the PC. 

Timing mode The eight functions that each channel can perform. 

Toggle mode Toggles its output state upon every input pulse. 

Trigger An input signal that initiates a channel function. 

Trig220 The control software for the LC220. 

Trigger validation mode Also known as “Noise Suppression” mode. This 

timing mode eliminates false triggers due to noise 

on the input signal by requiring the signal to remain 

high (or low) for a specified duration. 

Update firmware This menu function allows you to upgrade your 

LC220’s firmware to the latest version, available at 

www.labsmith.com. 
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To Our Valued Customers 

User’s Manual and Trig220 Control Software: 

To obtain the most up-to-date version of this user’s manual and Trig220 

Control Software please refer to our website at: 

http://www.labsmith.com 

Corrections to this user’s manual and Trig220 Control 

Software: 

Please contact support@labsmith.com to report any information that is 

missing or in error in this user’s manual or in the Trig220 Control 

Software.  

Sample Files and Application Notes: 

Sample files, application notes and other technical information are 

available on our website. To request sample files specific to your 

application, please contact support@labsmith.com. 


